Running CellDesigner™ Simulation with Control Panel

Quick Tutorial

2012-10-10
for CellDesigner Ver. 4.3

The Systems Biology Institute
http://www.systems-biology.org/

Mitsui Knowledge Industry Co. Ltd.
http://bio.mki.co.jp/en/

Keio University, Dept. of Biosciences and Informatics
http://www.bio.keio.ac.jp/
Contents

1. Introduction ......................................................................................................................................... 4
   Sample file used in this document: ........................................................................................................ 4

2. Quick Tutorial of Simulation .................................................................................................................. 6
   2.1 Before you start simulation ................................................................................................................ 6
   2.2 To run a basic simulation: .................................................................................................................. 8
   2.3 To view the values of the simulation results: ....................................................................................... 9
   2.4 To save an image of the simulation result: ......................................................................................... 9
   2.5 To change the solver to COPASI or Simulation Core Library: ......................................................... 11

3. Change the Initial Quantities of Species and Parameter Values ............................................................ 12
   3.1 To change the initial quantity for Species: .......................................................................................... 12
   3.2 To change the parameter values: ....................................................................................................... 12

4. Change Amount for Simulation ............................................................................................................... 13
   4.1 To run simulation changing the amount of Species at specific time: ............................................. 13
   4.2 To export and import the Change amount matrix: .......................................................................... 13

5. Parameter Scan ...................................................................................................................................... 15
   5.1 To scan parameters: .......................................................................................................................... 15
   5.2 To see the results of parameter scan: ................................................................................................. 15
   5.3 To output the results of parameter scan: .......................................................................................... 16

6. Interactive Simulation ............................................................................................................................. 17
   6.1 To run interactive simulations: ......................................................................................................... 17
   6.2 To change the data range of slider bars: ............................................................................................ 18

7. Graph Area ............................................................................................................................................ 19
   7.1 To highlight a Species in the Graph Area: .......................................................................................... 19
   7.2 To show/hide Species displayed in the Graph Area: ......................................................................... 19
   7.3 To change the line color of the graph: ............................................................................................... 19
   7.4 To search for species: ........................................................................................................................ 20
   7.5 To convert the graph to a scatter plot: ............................................................................................... 20

8. Save/Open the Results of Simulation (File I/O) .................................................................................... 22
   8.1 To save a simulation result into files: ............................................................................................... 22
   8.2 To save simulation conditions into files: .......................................................................................... 22
   8.3 To open a condition and result saved in files: .................................................................................. 23

9. Parameter Polymorphism ......................................................................................................................... 24
   9.1 Parameter Polymorphism Workflow .................................................................................................. 25
   9.2 Workflow Step 1: Define the baseline experiment: ......................................................................... 25
   9.3 Workflow Step 2: Set the new experiment: ....................................................................................... 28
   9.4 Workflow Step 3: Load and Run the new experiment: .................................................................... 30
   9.5 Tips for Good Practice: .................................................................................................................... 31
Acknowledgements

- Rainer Machné and Christoph Flamm at University of Vienna for providing us a library version of SBML ODE Solver (SOSlib).
- Ralph Gauges, Sven Sahle and Ursula Kummer at University of Heidelberg for the development of a library version of COPASI.
- Frank Bergmann and Herbert Sauro at University of Washington for helping us support SBW-2.x on CellDesigner.
- Andreas Dräger Alexander Dörr, and Roland Keller at University of Tübingen for providing us a library version of Simulation Core Library.
- Many thanks to the users who kindly provided us bug reports and feature requests!
1. Introduction

The “Control Panel” is designed to assist the users to simulate directly from CellDesigner controlling the amounts and parameters of the Species.

Calling directly SBML ODE Solver (http://www.tbi.univie.ac.at/~raim/odeSolver/) from CellDesigner, ControlPanel enables you to specify the details of parameters, changing amount, conducting parameter search, and interactive simulation with intuitive manner.

You can also choose COPASI or Simulation Core Library as an alternative solver. Please check the detail specification of each solver/simulator at its own website.

→ See also:
  - SBML ODE Solver (http://www.tbi.univie.ac.at/~raim/odeSolver/)
  - COPASI (http://www.copasi.org/)
  - Simulation Core Library (http://sourceforge.org/projects/simulation-core)

→ See also: Startup Guide

Sample file used in this document:

This document uses a sample model “MAPK.xml” originally provided with SBML ODE Solver. When you install CellDesigner, MAPK.xml is deployed in the /<your CellDesigner directory>/samples/ folder.

This MAPK.xml model has been slightly modified from a model obtained from http://sbml.org/models/.
The model has been published in Kholodenko BN. Negative feedback and ultrasensitivity can bring about oscillations in the mitogen-activated protein kinase cascades. Eur. J. Biochem. 267: 1583-1588 (2000).
2. Quick Tutorial of Simulation

2.1 Before you start simulation

Throughout this tutorial, we will use MAPK.xml, which can be found in the `<CellDesigner installation directory>/samples/` folder. All the formulae necessary for the simulation are already embedded in the Reactions. You can check the formulae in the CellDesigner’s Reactions list.

→ See also: Startup Guide or CellDesigner Online Help.

KineticLaw

<table>
<thead>
<tr>
<th>id</th>
<th>name</th>
<th>reactants</th>
<th>products</th>
<th>modifiers</th>
<th>math</th>
</tr>
</thead>
<tbody>
<tr>
<td>J0</td>
<td>J0</td>
<td>MKKK</td>
<td>MKKK_P</td>
<td>MAPK_PP</td>
<td>V1 * MKKK / ((1 + pow(MAPK_PP / Ki, n)) * (K1 + MKKK))</td>
</tr>
<tr>
<td>J1</td>
<td>J1</td>
<td>MKKK_P</td>
<td>MKKK</td>
<td></td>
<td>V2 * MKKK_P / (KK2 + MKKK_P)</td>
</tr>
<tr>
<td>J2</td>
<td>J2</td>
<td>MKK</td>
<td>MKK_P</td>
<td>MKKK_P</td>
<td>k3 * MKKK_P * MKK / (KK3 + MKK)</td>
</tr>
<tr>
<td>J3</td>
<td>J3</td>
<td>MKK_P</td>
<td>MKKK_P</td>
<td>MKKK_P</td>
<td>k4 * MKKK_P * MKK_P / (KK4 + MKKK_P)</td>
</tr>
<tr>
<td>J4</td>
<td>J4</td>
<td>MKK_PP</td>
<td>MKK_P</td>
<td></td>
<td>V5 * MKK_PP / (KK5 + MKK_PP)</td>
</tr>
<tr>
<td>J5</td>
<td>J5</td>
<td>MKK_P</td>
<td>MKK</td>
<td></td>
<td>V6 * MKK_P / (KK6 + MKK_P)</td>
</tr>
<tr>
<td>J6</td>
<td>J6</td>
<td>MAPK</td>
<td>MAPK_P</td>
<td>MKKK_PP</td>
<td>k7 * MKK_PP * MAPK / (KK7 + MAPK)</td>
</tr>
<tr>
<td>J7</td>
<td>J7</td>
<td>MAPK_P</td>
<td>MAPK_PP</td>
<td>MKKK_PP</td>
<td>k8 * MKK_PP * MAPK_PP / (KK8 + MAPK_PP)</td>
</tr>
<tr>
<td>J8</td>
<td>J8</td>
<td>MAPK_PP</td>
<td>MAPK_P</td>
<td></td>
<td>V9 * MAPK_PP / (KK9 + MAPK_PP)</td>
</tr>
<tr>
<td>J9</td>
<td>J9</td>
<td>MAPK_P</td>
<td>MAPK</td>
<td></td>
<td>V10 * MAPK_P / (KK10 + MAPK_P)</td>
</tr>
</tbody>
</table>
### Species

<table>
<thead>
<tr>
<th>class</th>
<th>id</th>
<th>name</th>
<th>compartment</th>
<th>quantity type</th>
<th>initialQuantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROTEIN</td>
<td>MKK</td>
<td>MKK</td>
<td>uVol</td>
<td>Amount</td>
<td>280</td>
</tr>
<tr>
<td>PROTEIN</td>
<td>MKKK</td>
<td>MKKK</td>
<td>uVol</td>
<td>Amount</td>
<td>90</td>
</tr>
<tr>
<td>PROTEIN</td>
<td>MAPK</td>
<td>MAPK</td>
<td>uVol</td>
<td>Amount</td>
<td>280</td>
</tr>
<tr>
<td>PROTEIN</td>
<td>MKKK_P</td>
<td>MKKK</td>
<td>uVol</td>
<td>Amount</td>
<td>10</td>
</tr>
<tr>
<td>PROTEIN</td>
<td>MKK_P</td>
<td>MKK</td>
<td>uVol</td>
<td>Amount</td>
<td>10</td>
</tr>
<tr>
<td>PROTEIN</td>
<td>MAPK_P</td>
<td>MAPK</td>
<td>uVol</td>
<td>Amount</td>
<td>10</td>
</tr>
<tr>
<td>PROTEIN</td>
<td>MAPK_PP</td>
<td>MAPK</td>
<td>uVol</td>
<td>Amount</td>
<td>10</td>
</tr>
</tbody>
</table>

### Parameters

<table>
<thead>
<tr>
<th>scope</th>
<th>id</th>
<th>name</th>
<th>value</th>
<th>units</th>
<th>constant</th>
</tr>
</thead>
<tbody>
<tr>
<td>local:Reaction(J0)</td>
<td>V1</td>
<td></td>
<td>2.5</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>local:Reaction(J0)</td>
<td>Ki</td>
<td></td>
<td>9</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>local:Reaction(J0)</td>
<td>n</td>
<td></td>
<td>1</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>local:Reaction(J0)</td>
<td>K1</td>
<td></td>
<td>10</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>local:Reaction(J1)</td>
<td>V2</td>
<td></td>
<td>0.25</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>local:Reaction(J1)</td>
<td>KK2</td>
<td></td>
<td>8</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>local:Reaction(J2)</td>
<td>k3</td>
<td></td>
<td>0.025</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>local:Reaction(J2)</td>
<td>KK3</td>
<td></td>
<td>15</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>local:Reaction(J2)</td>
<td>V0</td>
<td></td>
<td>111</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>local:Reaction(J2)</td>
<td>K0</td>
<td></td>
<td>1</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>local:Reaction(J3)</td>
<td>k4</td>
<td></td>
<td>0.025</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>local:Reaction(J3)</td>
<td>KK4</td>
<td></td>
<td>15</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>local:Reaction(J4)</td>
<td>V5</td>
<td></td>
<td>0.75</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>local:Reaction(J4)</td>
<td>KK5</td>
<td></td>
<td>15</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>local:Reaction(J5)</td>
<td>V6</td>
<td></td>
<td>0.75</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>local:Reaction(J5)</td>
<td>KK6</td>
<td></td>
<td>15</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>local:Reaction(J6)</td>
<td>k7</td>
<td></td>
<td>0.025</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>local:Reaction(J6)</td>
<td>KK7</td>
<td></td>
<td>15</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>local:Reaction(J7)</td>
<td>k8</td>
<td></td>
<td>0.025</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>local:Reaction(J7)</td>
<td>KK8</td>
<td></td>
<td>15</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>local:Reaction(J8)</td>
<td>V9</td>
<td></td>
<td>0.5</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>local:Reaction(J8)</td>
<td>KK9</td>
<td></td>
<td>15</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>local:Reaction(J9)</td>
<td>V10</td>
<td></td>
<td>0.5</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>local:Reaction(J9)</td>
<td>KK10</td>
<td></td>
<td>15</td>
<td></td>
<td>TRUE</td>
</tr>
</tbody>
</table>
2.2 To run a basic simulation:

1. Open the sample file MAPK.xml in the samples folder.
2. In the Menu, select Simulation - ControlPanel.
3. The ControlPanel dialog box appears.

4. Click Execute button.
5. A graph will be drawn in the right pane.

6. By default, the simulation End Time is set to “100” and Num. of Points to plot is “100”.
   You can enter different values into End Time and Num. of Points to change these values.
7. Change End Time to “1000”.

8. Click Execute button.
9. A graph is drawn with a longer time.
2.3 To view the values of the simulation results:

1. Click the Table Tab behind the Graph tab in the right pane.
2. You can view the results of the simulation in a table format. You can switch species, fluxes, parameters and compartment by clicking the relevant tabs.

→ Note: You can copy the data from the table by specifying the area in the table. The data is treated as CSV format so you can paste it directly to a spreadsheet.

2.4 To save an image of the simulation result:

You can save the graph image into five types of graphical file formats: BMP, JPEG, PNG, TIFF, and PNM file format: (".bmp", ".jpg", ".png", ".tif" and ".pnm").

1. Select Save Image / Print from the File menu.
2. The Image Config Dialog dialog box appears.
3. Click **Config** button to specify the graph items such as **Title**, **Legend** and **Plot** ranges.

4. Click **OK**. Click **Save Image** button, then select the file format and specify the file name for a graph image.
2.5 To change the solver to COPASI or Simulation Core Library:

COPASI is a software application for simulation and analysis of biochemical networks. Simulation Core Library is also a simulation software. You can choose the simulation solver of your choice for simulation of your model.

1. Click the COPASI or SimulationCore radio button.
2. Click Execute.

→ To install Copasi, see also README.txt or "Installation and Startup" section in CellDesigner’s Startup Guide,
3. Change the Initial Quantities of Species and Parameter Values

It is possible to run the simulation with the values in **Species** and **Parameters** tabs changed. The values changed in the ControlPanel are updated to the corresponding values in the CellDesigner itself.

### 3.1 To change the initial quantity for Species:

1. Click the **Species** tab.

   ![Species Table]

2. Change the initial quantity by clicking each blue cell for the values to be modified.
3. Click **Execute** button to run the simulation with the new values.

### 3.2 To change the parameter values:

1. Click the **Parameters** tab.

   ![Parameters Table]

2. Change the initial parameters by clicking each blue cell for the values to be modified.
3. Click **Execute** button to run the simulation with the new parameters.
4. Change Amount for Simulation

In order to simulate the time course of Specie resulting from forced expression of a gene/genes on a certain time, ControlPanel implements the **Change amount** functionality. With this functionality, you can run a simulation with the amount of Species at a specific time being changed to a desired value.

→ Note: COPASI does not support the Change Amount functionality.

4.1 To run simulation changing the amount of Species at specific time:

1. Click the **Change amount** tab.
2. Check the **Change amount** checkbox.
3. In the **Change amount** matrix, enter the amount of **Species** at the time specified at the header row.
4. Click the **Execute** button.

4.2 To export and import the Change amount matrix:

The **Change amount** matrix can be edited by external software such as MS Excel by exporting the matrix to a CSV file. Conversely, a CSV file edited outside can be imported to ControlPanel.

1. Select **Export** from the **Data** menu.
2. Enter a file name and click **Save** button.
   (A CSV file will be created with the specified file name.)
3. Open the CSV file using other software such as MS Excel, edit values, and save them.
Running CellDesigner™ Simulation with ControlPanel

<table>
<thead>
<tr>
<th>species/time point</th>
<th>0</th>
<th>30</th>
<th>60</th>
<th>90</th>
</tr>
</thead>
<tbody>
<tr>
<td>MGKK</td>
<td>90</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MGKK_P</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MKK</td>
<td>280</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MKK_P</td>
<td>10</td>
<td>100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MKK_PP</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MAPK</td>
<td>280</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MAPK_P</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MAPK_PP</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

e.g. an example of .CSV file exported from Control Panel.

4. Select **Import** from the **Data** menu.
5. Select the file that you have just edited and click **Open** button.
5. Parameter Scan

You can run simulations in a batch job to scan parameters. By setting the range and interval of each parameter to scan, ControlPanel runs the simulation with each parameter changing within the specified range with the value incremented by the specified interval.

5.1 To scan parameters:

1. Click the Parameter Scan tab.
2. Check the Scan parameter checkbox.
3. Select the Initial value or Parameter value option.
4. Select the name of a parameter to change from the Name list.
5. Input values into From, To, and Interval for a parameter scan, which correspond to the start value, the end value, and the interval respectively.
6. Click Execute button to start simulation scanning of the specified parameters.

→ Note: If you check two Scan parameter checkboxes, you can scan two parameters. The simulations are executed using the combination of the two parameters.

5.2 To see the results of parameter scan:

1. If the message “The simulation was completed” is displayed in the Information dialog box, click OK.
2. Click the flashing Result tab. (The rightmost tab)
3. Select the result you want to see and click the Show Graph button.

→ Note: If you specify only one parameter on parameter scanning, you should specify Overlay Setting to view the graph.
5.3 To output the results of parameter scan:

1. Click **Writing**.
2. Specify the file name and the directory to save the file.
3. The output of the parameter scan results will be saved in text file format.
6. Interactive Simulation

ControlPanel allows you to see real-time results of simulations. You should use "Interactive simulation" for this purpose.

6.1 To run interactive simulations:

1. Click the **Interactive Simulation** tab.
2. Select the **Initial value** or **Parameter value** option.
3. To change a parameter, slide each slider bar or input a value into the box on the right side of the slider bar for that parameter.

→ Note: The minimum and maximum values of the slider bars were automatically defined based on the initial values of SBML. However, you can change the data range of the slider bars.
6.2 To change the data range of slider bars:

1. Click the **Define Range** button.
2. In the **Define Slider Range** dialog box, change the minimum and maximum values and click **OK** button.
7. Graph Area

7.1 To highlight a Species in the Graph Area:

1. In the Control Panel, click the Graph tab.
2. Click a cell in the Species column in the table.
3. The corresponding line in the Graph will be highlighted.
4. Next, click a line in the Graph.
5. The corresponding table row in the right pane will be highlighted.

7.2 To show/hide Species displayed in the Graph Area:

1. In the Control Panel, click the Graph tab.
2. Select/unselect checkboxes in the Visible column in the right pane.
3. The checked Species are displayed/hidden on the Graph.

7.3 To change the line color of the graph:

1. In the Control Panel, click the Graph tab.
2. Click a cell in the Color column in the right pane.
3. The Pick a Color dialog box appears.
4. Select a color and click OK button.
7.4 To search for species:

1. In the ControlPanel, in the species search textbox, enter your search word
2. Click search.

7.5 To convert the graph to a scatter plot:

You can convert the line chart to a scatter plot and compare the data of an arbitrary pair of Species.

1. In the ControlPanel, select any two Species by ticking the checkboxes in the Visible column.
2. Observe that the graph has been reduced to two curves.
3. Tick the show scatter plot checkbox.
4. Observe that in the new graph the x-axis does not indicate time series any more.

5. Select the reverse checkbox to change the x- and y- axes.
8. Save/Open the Results of Simulation (File I/O)

The result of a simulation is stored in three file types:

- a model file (*.xml; SBML)
- a simulation condition file (*.xml; SED-ML)
- simulation result files (*.txt)

The model file (SBML) has a one-to-one correspondence with the simulation condition file (*_sed.xml). SED xml

→ See also: For details on SED-ML, please refer to the website: http://sed-ml.org

For example, if you stored the results of two simulations run by model1.xml and newmodel.xml into the "models" directory, the contents of the directory will be:

```
[models]
  +---------model1.xml (SBML)
  +---------model1_sed.xml (parameters setting for the model 1)
  +---------[model1] (the result folder for the model 1)
    +---------result1.txt (simulation result 1)
    +---------result2.txt (simulation result 2)
    +
    
  +---------newmodel.xml (a new model)
  +---------newmodel_sed.xml (parameters setting for the new model)
  +---------[newmodel] (the result folder for the new model)
    +---------result1.txt (simulation result 1)
    +---------result2.txt (simulation result 2)
```

8.1 To save a simulation result into files:

1. Select Save As from the File menu of ControlPanel.
2. Enter the file name for a simulation result and click the save button.
3. Then two types of file having extensions ".xml" (SBML), and ".txt" are created.

8.2 To save simulation conditions into files:

1. Select Save Condition As from the File menu of ControlPanel.
2. Enter the file name for simulation conditions and click the save button.
3. Then two types of file having extensions "SED.xml" and ".txt" are created.

→ See also: [9. Parameter Polymorphism].
8.3 To open a condition and result saved in files:

1. Select **Open Condition** from the **File** menu of CellDesigner.
2. Select an SED (.xml) file and click the **Open** button.
3. The corresponding condition (.xml) file and result files (*.txt) are automatically imported so that you can start the ControlPanel and see the result.
9. Parameter Polymorphism

When you run the simulation, it is important to run the simulation with various conditions. Parameter polymorphism is the function that allows setting the various conditions for the simulation.

This feature has been introduced in CellDesigner4.2 for advanced users of the simulation panel. It allows users to define multiple in-silico experiments on a given model (baseline) by defining specific set of parameters and initial conditions (parameter polymorphism) on top of the baseline. Users can save the experiments in SED-ML format (http://sed-ml.org) and reload then at a later stage in time to execute the in-silico experiments defined on the baseline model.

→ Note: The Simulation Experiment Description Markup Language (SED-ML) (http://sed-ml.org) is an XML-based format for encoding simulation experiments, following the requirements defined in the Minimum Information About a Simulation Experiment (MIASE) guidelines (http://www.biomodels.net/miase/). SED-ML allows to define the model to use, the experimental task to run and which result to produce.

→ See also: For details on MIASE, please refer to the following paper: Waltemath et al. Minimum Information About a Simulation Experiment (MIASE). PLoS Comput Biol (2011) vol. 7 (4) pp. e1001122

Changes to Initial Quantity, Time Span, and other parameters can be registered as an “experiments” in CellDesigner. Experiments are displayed in a tree format in the left pane and the experimental conditions can be loaded by clicking them.

→ Note: This experiment panel is being hidden in the default view. Please expand to view the panel.

Parameters / conditions that can be saved in the Experiments are as follows:

- End Time (Time span)
- Num. of Points (Time span)
- Exp. (Error tolerance)
- Solver
- Initial Quantity (Species)
- boundary condition (Species)
- constant (Species)
- Value (Parameters)
- constant (Parameters)
- All items on Change amount tab
- All items on Parameter Scan tab
9.1 Parameter Polymorphism Workflow

The following guide takes a step-by-step tour of the Parameter Polymorphisms Panel:

In summary, the workflow consists of three major steps:

- Step 1: Define the baseline experiment
- Step 2: Set the new experiment
- Step 3: Load and Run the new experiment

Detail operations for each step are described in the following sections:

9.2 Workflow Step1: Define the baseline experiment:

1. Open a model file for simulation in the CellDesigner canvas and click Simulation menu to open the Control Panel.

The left hand panel is the new parameter polymorphism panel. It serves as the in silico experiment dashboard.

→ Note: By default, the Experiment panel is being collapsed. To display the panel, click to un-collapsed it.
The default experiment (expt1) is being displayed. This is the baseline experiment. Check to see if the baseline experiment runs its simulation OK.

2. Click **Initialize** button to set the baseline parameters.
3. Click **Execute** the baseline simulation and check the results.

To save the baseline condition, click **Save Condition** button. For the first time, it will prompt for the file path and name to save the experimental conditions (SED-ML and results file).

→ **Tip:** It is recommended to rename the default experiment (expt1) to “baseline” by clicking File – Rename Experiment option before saving.
9.3 Workflow Step 2: Set the new experiment:

1. To define a new experiment (by changing parameters or initial concentration of species), user can edit the respective panels (shown below). In the following example, change the concentration of A to 5 in the [Species] Tab.

2. Click **Save Condition** button, once the new conditions are defined. It will prompt the user for overwrite existing condition. Select **NO** to define a new experimental condition (new parameter polymorphism) * Select **YES** to overwrite the existing condition.

   Here select **NO** to proceed to define the new experiment.
3. Specify the new Experiment name.

The conditions are saved with the name specified in the SED-ML file format. The new experiment name will appear on the parameter polymorphism panel.
4. Select the new experimental name from the left panel, then Click **Execute** to execute the simulation with the new experimental conditions.

By Selection, each condition on the panel will load the specific parameters associated with that condition. In this manner, it is possible to define multiple conditions on a baseline model.

Once the user has defined all the experiments, You can close the control panel.

→ **Tip 2:** Once done with the Parameter Polymorphism panel, before closing the Control Panel, select the baseline experiment again.

→ See also: [9.5 Tips for Good Practice]

### 9.4 Workflow Step 3: Load and Run the new experiment:

In order to re-load the conditions, the SED-ML file associated with the baseline model can be opened.

1. Select **File – Open Condition**, then selected the previously saved SED-ML file. The confirmation dialog box is shown denoting the original baseline model file with which the parameter polymorphisms are associated.

→ **CAUTION:** Loading the SED-ML file with a different baseline model can lead to incorrect simulation results or cause the Control Panel to crash.
9.5 Tips for Good Practice:

- **Tip 1:** DO NOT click on **Initialize** button on any conditions (except the baseline) as it would replace the user defined parameters with the original model baseline value.

- **Tip 2:** Once done with the Parameter Polymorphism panel, before closing the Control Panel, select the baseline experiment again. This will load the original parameters (baseline values) to the model opened on the CellDesigner canvas. This way can ensure that the original model file always stores the baseline conditions only while the polymorphism conditions are stored in the SED-ML file.

→ See also: For details on SED-ML file format, check the SED-ML format specification:  
http://sed-ml.org